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1 General. 

1.1 What kind of encryption used by SecureITnet? 

There are two encryptions being performed by SecureITnet: 
 

1. Encryption of backup data - This is being done by 128-bit symmetric key encryption (AES, 
TripleDES, TwoFish). 256-bit is not available because it requires too much CPU and it is not really 
required. (128-bit is currently being used by most banks) 

2. Encryption of backup traffic - This is being done by 1024 bit RSA public key encryption. The 
strength of the encryption depends on the key size you use when you generate your CSR before 
submitting to your CA. 1024 bit is what is being used by most CAs. 

 
^Back to top 

1.2 Are there any command line tools for SecureITnet? 

Yes, there are scripts in [SecureITnet Program Home]\bin and they are described below: 
 
Windows 

 Decrypt.bat: decrypts the specified backup files 

 install.bat: installs the SecureITnet icon to the System Tray and registers the Online Backup 
Scheduler as a service 

 Install-Scheduler.bat: registers the Online Backup Scheduler as a service 

 RegisterVSS.bat: re-registers Microsoft’s Volume Shadow Copy service DLLs 

 Remove-Scheduler.bat: un-registers the Online Backup Scheduler service 

 Restore.bat: restores the specified snapshot of the backup set to the specified location 

 RunBackupSet.bat: runs the specified backup set 

 RunSecureITnet.bat: launches the Online Backup Manager user interface 

 Run-Scheduler.bat: starts the Online Backup Scheduler service 

 SeedLoad.bat: runs seed load for the specified backup set to the specified location 

 Uninstall.bat: removes the SecureITnet icon from the System Tray and un-registers the Online 
Backup Scheduler service 

Linux 

 BackupManager.sh: launches the Online Backup Manager user interface 

 Configurator.sh: configures client parameters such as Backup Server address, username/password, 
encrypting key, etc. 

 Decrypt.sh: decrypts the specified backup files 

 Restore.sh: restores the specified snapshot of the backup set to the specified location 

 RunBackupSet.sh: runs the specified backup set 

 Scheduler.sh: starts the Online Backup Scheduler service 

 SeedLoad.sh: runs seed load for the specified backup set to the specified location 

 StopScheduler.sh: stops the Online Backup Scheduler service 

 

*You may have to set some variables in these scripts and more instructions are provided. 

 
^Back to top 

1.3 How does SecureITnet detect changes in files? Does it use the 

Archive bit? Some tape backup software resets the Archive bit. 

Would this affect SecureITnet when backing up the same data? 

SecureITnet compares timestamps of files on the server with the corresponding copies on client machine. 
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Archive bit is not used as it does not detect relocated files. Therefore tape backup would not affect SecureITnet.  
 

^Back to top 

1.4 I am having problems with my scheduled backup, why? 

If you are backing up files from a network drive, please check if you have included the valid “Network 
Resources Authentication” information for the backup set. This is required for scheduled backups that 
access any network resources.  

You can refer to the following screenshot: 

http://download.ahsay.com/support/screenshots/Network_Resources_Authentication.JPG  

 

^Back to top 

1.5 Does SecureITnet work with dial-up connections? 

It makes no difference to SecureITnet if the connection is always on or dial-up.  
 
If you want Windows to connect to the ISP automatically when a backup starts, you can go to [Control Panel] -
> [Internet Options] -> [Connections] and select “Always dial my default connection”.  

 
^Back to top 

1.6 I cannot get proxy authentication to work with SecureITnet, why? 

If you are using port 80, please check whether your proxy server accepts "HTTP CONNECT" calls on port 80. 
You may also want to try other ports like 443 to see if your proxy server accepts that. 

 

^Back to top 

1.7 Can I backup an entire Operating System? 

Currently, it is not possible to do hard disk image backup with SecureITnet. However, you can still 
backup/restore the operating system by doing the followings: 
 
To backup all files including the operating system, please do this: 

1. Add all files to your backup source 

2. Add a SystemState backup type to your backup account (Windows only) 

 
To restore all files including the operating system, please do this: 

1. Re-install the operating system and applications 

2. Restore the SystemState backup to your machine (Windows only) 
- To restore the System State data on a domain controller, you must first start your computer in a 
special startup option called "Directory Services Restore Mode". To access "Directory Services 
Restore Mode", press F8 during startup and select it from the list of startup options. 

3. Restore all files to your machine 

 
^Back to top 

1.8 Does SecureITnet copy the same set of files regularly? 

After the initial upload, subsequent backup jobs will only transfer the modified or new data to the Backup server. 
It depends on the nature of the data, but normally, less than 2% of all data is modified.  

 

^Back to top 

http://download.ahsay.com/support/screenshots/Network_Resources_Authentication.JPG
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1.9 Transfer Block Size is 128Kb by default. Is there a reason for 

this? 

Backup data is transferred in blocks (instead of file by file) to minimize connection negotiation roundtrips. It is 
not the TCP/IP block size. This setting is optimal for the backup operation. 

 

^Back to top 

1.10 How can I backup a huge data set over the Internet? 

If you have a lot of data (e.g. 300GB) to backup to the backup server, it would take a considerable amount of 
time to perform the first full backup over the Internet. You can try the following method:  

1. Use the Seed Loading Utility to backup your backup set to a local hard disk (instead of directly 
transfer to the backup server)  

2. Send the backup data, using a removable hard disk, to your backup service provider.  

3. The administrator can then load all your backup files from your removable hard disk into your 
backup account. This could save you days (even weeks) of performing your first full backup.  

In addition, subsequent backups are incremental (only new or updated files will be uploaded to the server), the 
amount of data transfer should be relatively small.  
 
Please refer to the User’s Guide for details on the “Seed Loading Utility”. 
 
^Back to top 

1.11 What is the best way to restore a huge data set? 

You can copy the data of the particular backup set on OBS to a removable media, e.g. external hard disk, and 
ship it to your client. Your client can then use the “Decypt Files Tool” in SecureITnet to restore the backup 
data from the removable media to its original format. 
 
^Back to top 

1.12 Does In-File Delta backup require a temporary working directory?  

SecureITnet requires a temporary storage for the delta file before it gets sent to the server.  

For example:  

If you have a 10GB file that has already been backed up to the server and you have updated 10MB of 
this file. Then you need to have at least 10MB of free space in the temporary directory for the delta file.  

*Note: Certainly you do not need 10GB of free disk space.  

Also, if you want to backup 5 x 10GB files in the same situation. You will only need 10MB of free space (not 5 x 
10MB), because each delta file will be automatically deleted right after it has been backed up.  

 

^Back to top 

1.13 What is the average compression ratio? 

All backup files are compressed and encrypted before uploading to the Backup Server, the average 
compression ratio for text-based file is around 4:1. However, no further compression can be made on files that 
are already in compressed format (e.g. JPG, ZIP). In general, you can assume a 2:1 compression ratio when 
you are backing up a file set with variety types. 

 

^Back to top 

1.14 Can I change my encrypting key? 

The encrypting key cannot be changed once you setup your Backup Set. This is necessary for the integrity of 
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the Backup Set, making sure that backup data is only encrypted by one key. Otherwise, you will have problems 
remember two encrypting keys when you want to restore your files in the future. 
 
You need to recreate your Backup Set if you really want to change your encrypting key.  

 

^Back to top 

1.15 If the “Use Login Password as Encrypting Key” option was 

selected when creating the backup set. Why I cannot restore 

the backup data with my most current login password? 

By selecting the “User Login Password as Encrypting Key” option when creating a backup set, SecureITnet will 
set your login password as the encrypting key for the backup set. Once set, even if you change your login 
password afterward, the encrypting key will remain as your original password. In other words, if you have 
changed your login password, you still need to use the original password to decrypt and restore the backup set. 
 
Currently, if the encrypting key is forgotten or lost, the backup set can never be restored. It is not possible to 
restore without the key. 
 
You can find out the encrypting key from the corresponding SecureITnet, please refer to 
http://download.ahsay.com/support/screenshots/EncryptingKey.jpg  

 

^Back to top 

1.16 When select the backup option “local hard drive” to backup to 

external hard drive, it fails in the middle of the process, why? 

Please check if the external hard drive is in FAT32 volume format. And also check whether there is any folder 
containing more than 32000 files and there is no file bigger than 4GB within your backup set. It is a FAT32 
limitation, you may try to convert the FAT32 volume to NTFS.   
 
^Back to top 

1.17 What are the advantages and disadvantages of backing up 

multiple computers using a single backup account?  

Advantages 

 You require less backup accounts 

 You can use one username and password to configure the backup setting for all Backup Sets 

Disadvantages 

 You must use different backup sets for different computers 

 Whenever a new backup set is created under the backup account, you need to go back to all 
computers using the same backup account to uncheck the “Run scheduled backup on this 
computer” option for the new backup set (Since backup setting is saved on server and new 
backup set is default to run on all computers, i.e. with the option checked). 

 Improper configuration could easily cause problems, which are difficult to debug. 

 

^Back to top 

 
^Back to top 

 

^Back to top 

1.18 Is it possible to do incremental or differential backups with 

http://download.ahsay.com/support/screenshots/EncryptingKey.jpg
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MySQL? 

MySQL backup is done with SQL Dump file, and it generates a single file which is then uploaded. These backup 
files usually very large size and it takes time to backup to the server. At this moment, it is not possible to do 
incremental dump with mysqldump. But our In-File Delta feature shall ensure that, instead of the entire backup 
file, only the changed data blocks within the dump file are uploaded to the Backup Server.  

 

^Back to top 

1.19 How does the “Remove retention files for overlap policy” under 

Advanced Retention Policy work? 

In general, daily snapshots followed by a weekly snapshot or a monthly snapshot, etc. will be removed; weekly 
snapshots followed by a monthly snapshot or a quarterly snapshot, etc. will be removed; and so on.  
 

This is illustrated by the following example. 

Assume today is 17Jan06, and the Advanced Retention Policy is as follows:  

 Daily: retain for 7 days 

 Weekly: retain for 4 weeks (the job will be performed on Saturday) 

 Monthly: retain for 3 months (the job will be performed on 1st of each month) 

If “Remove retention files for overlap policy” is NOT enabled: 

Then a total of 14 snapshots (7+4+3) will be kept on the server accordingly, i.e.:  

(Daily): 10Jan06, 11Jan06, 12Jan06, 13Jan06, 14Jan06, 15Jan06, 16Jan06 
(Weekly): 24Dec05, 31Dec05, 7Jan06, 14Jan06 
(Monthly): 1Nov05, 1Dec05, 1Jan06 

If “Remove retention files for overlap policy” is enabled: 

Then only the following snapshots are kept: 1Nov05, 1Dec05, 1Jan06, 14Jan06, 15Jan06, 16Jan06.  

 
Specifically, the weekly policy overrides the daily policy so 10Jan06, 11Jan06, 12Jan06 and 13Jan06 will be 
removed. The monthly policy overrides the weekly policy, and 24Dec05, 31Dec05 and 7Jan06 will be removed 
as well. 
 
^Back to top 

1.20 What is incremental backup and how does In-File Delta work? 

In an incremental backup, only modified files will be uploaded to the Backup Server.  
 
On the other hand, In-File Delta is applicable to the physical files to be uploaded to the Backup Server, does not 
matter whether it is a MS SQL database file, MS Exchange transaction log file or any normal file in a 
FileBackupSet. Specifically, only the changed blocks in comparison to the original file on the Backup Server 
(delta file) will be uploaded. 
 
For each modified file, SecureITnet would determine whether the entire file or only delta file should be uploaded. 
If the entire file is to be uploaded, the old version of the file will be moved to the Retention area. Else if only the 
delta file is to be uploaded, the previous delta files will be moved to the Retention area and the Data area 
should contain the original full backup file, checksum file and the latest delta file of this file.  

 

^Back to top 

1.21 How does the “Auto” block size work under In-file Delta 

settings? 

If the block size is set to “Auto”, the effective block size (Started from SecureITnet v5.0.1.7) will be chosen 
from the following table based on the file size of the updated file: 
 
 File Size   Delta Block Size 
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 ------------  ---------------- 
 0 - 500M      4k 
 500M - 2G     8k 
 2G - 8G       16k 
 8G - 15G      32k 
 > 15G         64k 
 
^Back to top 

1.22 What happens when we do In-File Delta backup on a directory? 

When you do backup, the Online Backup software will do the followings: 

1. Check if any files are added, updated or deleted (the calculation of these files are based on files 
having the same filename). 

2. New files will be uploaded to the server in whole. 

3. Deleted files will be removed from Data area and placed into the Retention area on the Backup 
server. 

4. Updated files will be processed by the In-File delta option (i.e. only changed data blocks within the 
files will be uploaded to the Backup Server) 

 

^Back to top 

1.23 Does SecureITnet have to stop the application when doing 

online backups? 

SecureITnet can backup application data while the application is still running. Particularly, we have special 
agents for MS Exchange Server, MS SQL Server, Oracle, Lotus Notes and MySQL, which allows these 
applications to be backed up while they are online. With the Volume Shadow Copy feature started from 
SecureITnet v5.0, we are able to backup other types of applications while they are online. 

 

^Back to top 

1.24 What are Off-line backup, Logout backup reminder and Local 

backup features? 

Off-line Backup is basically designed for notebook users who are off-line most of the time, and cannot rely on 
backup schedule to backup regularly. The backup interval allows notebook users to specify the interval that they 
would like their data to backup. If this interval has elapsed, backup will run automatically once this machine is 
online. 

 

Logout Backup Reminder asks user if they would like to backup if they logout of the computer or shutdown 
their computer. 

 

Local Backup allows an extra copy of backup file to be kept on local hard disk when backup is running. 

 

^Back to top 

1.25 Why is my SecureITnet running backup once every hour? 

You might have “Off-line backup” enabled for every hour. Please do the following to disable that:  

1. Logon to SecureITnet  

2. Select the backup set that you want to disable the Off-line backup from the left panel 
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3. Select the [Extra Backup] node under the backup set node on the left panel 

4. Uncheck the [Enable off-line backup] checkbox under the “Off-line Backup” section 

5. If you want to do this to all backup sets, please repeat the previous step for each backup set 

Press the [Save Setting] button from the toolbar 
 

^Back to top 

1.26 How do I disable “logout backup reminder”? 

To disable the “System Logout Backup Reminder”, please do the followings: 

1. Logon to SecureITnet  

2. Select the backup set that you want to disable the Logout reminder from the left panel 

3. Select the [Extra Backup] node under the backup set node on the left panel 

4. Uncheck the [Enable System Logout Backup Reminder] checkbox under the “System Logout 
Backup Reminder (Windows)” section 

5. If you want to do this to all backup sets, please repeat the previous step for each backup set 

Press the [Save Setting] button from the toolbar 

1.27 What do I have to do in order to backup open files? 

You need to be on SecureITnet v5.0 or above, as well as support from the underlying OS. Windows XP and 
2003, by default, come with Volume Shadow Copy, which allows backup open file. For older platforms, e.g. 
Windows 9x/ME/NT/2000 or NetWare, we would recommend adding a third party open file manager option (e.g. 
St. Bernard Open File Manager - http://www.stbernard.com/) which might cost around US$100 for each 
workstation and US$300 for each server if open file backup is required. 
 
*Open file option is not required on Linux/Unix/Mac OS X because no files are held exclusively open by applications. 

 

^Back to top 

1.28 The SecureITnet crashes when opening [Backup Source] of a 

Lotus Domino/Notes backup set, what can I do? 

Check to see if you can find a hs_err_pid????.log file under the [SecureITnet Home], and if it contains the error 
"Unable to complete restart processing, err = Recovery Manager: Error from Logging Subsystem", please do the 
followings: 

1. Go to [Configuration], select [All Server Documents] and choose your corresponding server.  

2. [Disable] Transactional logging at Basics 

3. Go to [Control Panel] -> [Administrative Tools] -> [Services] and restart [Lotus Domain Server] 
Service 

4. Go to [Configuration] -> select [All Server Documents] and enable Transaction logging 

5. Make sure your logging style is "Archived" 

6. Go to [Services] and restart Lotus Domain Server Service again 

 

^Back to top 

 

 

 

http://www.stbernard.com/
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2 Microsoft Windows. 

2.1 How do I run SecureITnet with Microsoft ISA 2004? 

To connect SecureITnet to OBS through Microsoft ISA Server, please do the following to enable [Web Proxy] 
service on the ISA Server: 

1. Open [Start] -> [Programs] -> [Microsoft ISA Server] -> [ISA Server Management] 

2. On the left panel, select [Microsoft Internet Security and Acceleration Server] -> [SERVER] -> 
[Configuration] -> [Networks] 

3. On the top menu, select [Action] -> [New] -> [Network]. Enter a “Network Name” (e.g. Internal) 
and define the IP address range for your internal network  
(e.g. 192.168.1.0 - 192.168.1.255) 

4. Double click the new network that should now be added to on the bottom panel 

5. Select the [Web Proxy] tab  

6. Check both [Enable Web Proxy clients] and [Enable HTTP] checkboxes and choose a [HTTP port] 
for the web proxy service 

7. (Optional) Press the [Authentication] button, check the [Basic] checkbox and the [Require all users 
to authenticate] checkboxes if you want to enable and enforce proxy authentication 

8. Press the [OK] button to make the changes and press the [Apply] button to apply the changes 

9. Open [Online Backup Manager] from the system tray and press the [Options] button 

10. In the [Proxy Seting] section, select the [Proxy] radio button 

11. Enter the hostname/IP address of the ISA server in the [Proxy Address] text field and the TCP port 
for web proxy service on your ISA Server in the [Port] text field 

12. Press the [OK] button to connect to the server  
 
If you run into any problems connecting to the OBS from SecureITnet using ISA Server, please do the following 
to check if your request is being blocked: 

1. On the left panel of [ISA Server Management], select [Microsoft Internet Security and Acceleration 
Server] -> [SERVER] -> [Monitoring]  

2. Then select the [Logging] tab that appears on the right panel3. Click the [Edit Filter] link and 
create a filter with the following values: 

 [Log Record Type] equals [Web Proxy Filter] 

 [Destination IP] equals [The IP address of Offsite Backup Server] 

3. Press the [Start Query] button 

4. Open [Online Backup Manager] again and try connecting to the OBS using the same procedure 
above.  

 
Check if there are any errors generated in the log table. 

 

^Back to top 

2.2 The Windows version of SecureITnet installer hangs, what 

could be the problem? 

There are few things that could create errors during or after executing the installer. 

1. Make sure there is enough disk space on the machine. 

2. Make sure you do not have any anti virus software or PCanywhere running, as this may create 
problems with InstallAnywhere installers.  

3. There are also problems with InstallAnywhere installers and Dell OpenManager. If OpenManager 
has installed on the target system, be sure to disable it before installing SecureITnet. 

4. Hardware could cause errors as well, try set your [hardware acceleration display setting] to off. 
There are problems with certain versions of Java running along with certain video cards. 
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5. This may only be a Java problem. 

Also, if you are transferring this file from one machine to another, please be sure the file size is valid and you 
are transferring the file in binary mode. 
 
Java Testing 

Please try running any of the Swing demos that came with the Java runtime in 1.4.X and see if it hangs on 
Windows. In order to fix this problem, some knowledge base on the Internet suggested updating DirectX to at 
least DirectX 8.1. Most machines got this problem had DirectX 7.0 installed. (You can use the “dxdiag” 
command to find out the directX version) 

SUN recommended two workarounds for certain video card issues 

1. The following will pass properties to the installer's Virtual Machine: 
In Advanced Designer – Project -> Config -> Additional Arguments 
set that to "-Dsun.java2d.d3d=false -Dsun.java2d.noddraw=true" without the quotes. 

2. Set the following lax property in your LaunchAnywhere for your application's JVM:  
lax.nl.java.option.additional=-Dsun.java2d.d3d=false -Dsun.java2d.noddraw=true 
 
Add the same line to the uninstaller lax file, using a modify file action in your installer in post-
install. 

 
^Back to top 

2.3 The Installer doesn’t seem to work. How can I manually install 

SecureITnet on Windows? 

To manually install SecureITnet on Windows, you’ll need to copy and zipping the program directory (e.g. 
C:\Program Files\SecureITnet) from another machine with SecureITnet installed. Then do the followings on the 
machine you wish to manually install:  

1. Create the directory C:\Program Files\SecureITnet 

2. Unzip the SecureITnet program directory archive to C:\Program Files\SecureITnet 

3. Run C:\Program Files\SecureITnet\bin\install.bat 

4. Run C:\Program Files\SecureITnet\bin\Install-Scheduler.bat 

 
^Back to top 

2.4 Scheduled backup jobs are not running on my Windows 

machine, why? 

Please try the followings: 
 

1. Check if [Control Panel] -> [Administrative Tools] -> [Services] -> [Online Backup Scheduler] is 
available and started 

2. Check if C:\Program Files\SecureITnet\home.txt contains the home directory for your backup 
account (e.g. C:\Documents and Settings\Administrator\.obm) 

3. Check if C:\Program Files\SecureITnet\jvm\bin\SchedulerSecureITnet.exe exists 

4. Check if C:\Program Files\SecureITnet\log\Scheduler\info.log contains the startup loading entry, 
e.g. 

i. [2005/12/12 12:42:44] OS Name=Windows XP 

ii. [2005/12/12 12:42:44] OS Version=5.1 

iii. [2005/12/12 12:42:44] Scheduler Version=5.0.1.3e 

iv. [2005/12/12 12:42:44] Java Vendor=Sun Microsystems Inc. Version=1.4.2_10 

v. [2005/12/12 12:42:44] [info] Starting Scheduler, User:'backup-account', 
Home:'C:\Documents and Settings\Administrator\.obm' 

5. Check if C:\Documents and Settings\Administrator\.obm\log\Scheduler\debug.log contains the 
debugging information for your scheduler 

 
If your system settings is not the same as the above steps, please download a new installer (obm-win.exe) from 



  

 

SecureITnet v5.2….. 
User’s Guide.….. 

 

Forward ITC Limited Page 13 of 18 (May 12, 2008) 

 

 

our website or the customization portal and try again. 
 
^Back to top 

2.5 When setting up a Microsoft SQL Backup Set, I cannot list the 

available SQL servers, what can I do? 

You can try running “osql –L” in a command prompt, you should see the following: 
 
Servers: 
    (local) 
    SQLSERVER1\INSTANCE1 
    SQLSERVER2\INSTANCE2 
 
If you have a firewall installed, please disable it. UDP Broadcast must be allowed. 
 
^Back to top 

2.6 Why are the Microsoft SQL Server databases missing from the 

backup source list?  

If you have firewall installed on your network, please make sure UDP port 1434 is allowed on the SQL Server.  
 
^Back to top 

2.7 How do I backup NTFS permissions? 

For version 5.1 or later, NTFS permission is also backed up during the backup operation. For other versions, 
please do the followings: 

1. Download and install http://www.microsoft.com/downloads/details.aspx?FamilyID=E8BA3E56-
D8FE-4A91-93CF-ED6985E3927B&displaylang=en  

2. Add a pre-backup command to dump the NTFS permissions of all files you want to backup into a 
dump file. For example, if you want to have all files under C:\ drive to a C:\NTFS-Permission.txt, 
please add: 
 
"C:\Program Files\Windows Resource Kits\Tools\subinacl" /noverbose /outputlog=C:\NTFS-
Permission.txt /subdirectories C:\*.* /display 
 
to your pre-backup command. 

3. Add "C:\NTFS-Permission.txt" to the [Backup Source] of this backup set 

 
^Back to top 

2.8 How do I restore NTFS permissions? 

For version 5.1 or later, the backed up NTFS permission will be restored automatically. For other versions, 
assuming the NTFS Permission is being stored in "C:\NTFS-Permission.txt", please do the followings: 

1. Restore "C:\NTFS-Permission.txt" from the backup server using SecureITnet 

2. Apply all NTFS permissions backup to all your backup files by running:  
 
"C:\Program Files\Windows Resource Kits\Tools\subinacl" /playfile C:\NTFS-Permission.txt 

 
^Back to top 

2.9 How to set the recovery model of a MS SQL database to FULL? 

You can change the recovery model by running the following commands, run it along with each of the database 
that you want to run transaction log backup. 

C:\> osql -E -S SQLSERVER1\INSTANCE1 -Q "ALTER DATABASE xxx SET RECOVERY FULL" 

    Where 

SQLSERVER1\INSTANCE1 = the SQL Server and the corresponding instance 

xxx = the name of the database 

 

http://www.microsoft.com/downloads/details.aspx?FamilyID=E8BA3E56-D8FE-4A91-93CF-ED6985E3927B&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=E8BA3E56-D8FE-4A91-93CF-ED6985E3927B&displaylang=en
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2.10 The MS SQL or MS Exchange database backup job stores 2 

copies of the spooled database file in the "temporary directory" 

(tagged with different datetimes). This has taken up extra disk 

space, is this necessary?  

If you have interrupted any of the backup jobs, the file tagged with the datetime of the corresponding backup 
job will be renamed to its original filename just before it is uploaded. This is necessary as we need to ensure 
that the snapshot of different dates would not overwrite each other. 
 
If a backup job is still running, just let it runs to completion. If backup has been stopped already, just remove 
all files tagged with the corresponding datetime in the “temporary directory” and try to perform a full 
database backup again. 

 

^Back to top 

Please refer to: 
http://technet2.microsoft.com/WindowsServer/en/Library/2b0d2457-b7d8-42c3-b6c9-59c145b7765f1033.mspx  
 
^Back to top 

2.11 In Windows, when SecureITnet is creating Shadow Copy Set, it 

gets the “[ERROR] E_UNEXPECTED” error, what can I do? 

This is a Microsoft Volume Shadow Copy issue. Microsoft's recommendation is to try re-registering the Volume 
Shadow Copy Service. If you are on Win XP Pro, you can simply run the batch file available in C:\Program 
Files\SecureITnet\bin\RegisterVSS.bat or 

http://download.ahsay.com/support/RegisterVSS.bat.  

 
^Back to top 

2.12 How do I remove SecureITnet completely from my Windows 

machine? 

If you want to completely remove SecureITnet from Windows, after uninstalling the software from [Control 
Panel] -> [Add or Remove Programs], please do the followings: 

 Ensure that the SecureITnet installation directory is deleted (sometimes not removed when 
Windows somehow holds some of the files) 

 Remove the C:\Documents and Settings\administrator\.obm\ folder (intentionally left undeleted, 
as important information of the user and backup sets, such as the encryption keys, are stored here) 

 
^Back to top 

2.13 Windows network map drive connections are not stable, why? 

You may want to try editing a few Windows Parameters. 
 

SMB Size 

When running applications that copy or move a large amount of data to a remote server, the speed of such 
action is determined by network speed and by the SMB (a protocal related to Windows map drive) size.  

NT/2000 negotiates the SMB size and will generally set this to 4K blocks for applications that are moving or 
copying data to a remote server. By increasing this block size, you will allow the server to complete its file 
copies faster. This will increase the performance of the application making the copy/move calls. 

 

HKEY_LOCAL_MACHINE\System\Current Control Set\Services\LanmanServer\Paramerters 

 

http://technet2.microsoft.com/WindowsServer/en/Library/2b0d2457-b7d8-42c3-b6c9-59c145b7765f1033.mspx
http://download.ahsay.com/support/RegisterVSS.bat
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"SizReqBuf"= REG_DWORD 

Set Value To: 16000 = HEXDEC 

Ref: http://support.microsoft.com/default.aspx?scid=kb;en-us;320829 

     

Map Drive Auto Disconnect Settings 

Reference: http://support.microsoft.com/kb/138365/EN-US/ 

http://support.microsoft.com/default.aspx?scid=kb;en-us;297684  

 

HKEY_LOCAL_MACHINE\System\Current Control Set\Services\LanmanServer\Paramerters 

 

Autodisconnect to: fffffff 

 

Creating BAT file for better performance 

If you are still having problems, you may want setup a BAT file and scheduled this file to run every 10 minutes, 
please setup the BAT file as follow: 

BAT file settings: 
-------------------------- 

ping mapdrv 
ping 192.168.1.15 
net config server /autodisconnect:-1 
net use /persistent:yes 
net use "\\mapdrv\DATA STORAGE1" 
net use "\\192.168.1.15\DATA 
net use d: \\192.168.1.15\DATA STORAGE1 
net use e: "\\mapdrv\DATA STORAGE1" 
dir d:\  
dir e:\  

-------------------------- 

 mapdrv = your NAS device network name 

 192.168.1.15 = mapdrv 

 
In addition, create a host file on the server hosting the program, have the following entry in it:  

 mapdrv = 192.168.1.15 
 
And if you are on a 2003 server, refer to the following: 
Reference: http://support.microsoft.com/default.aspx?scid=kb;en-us;890553  
 
For Windows 2000, you may want to install the following Hotfix: 
Windows2000-KB903237-x86-ENU 
Reference: http://support.microsoft.com/default.aspx?scid=kb;en-us;903237  
 
^Back to top 

2.14 How do I restore a machine from my SystemState backup? 

To recovery a machine from scratch, you have to do the followings: 

1. Re-install the operating system 

2. Re-install all applications installed (You can do both of these easily by backing up the system 
yearly using Norton Ghost) 

3. Restore the SystemState backup onto the recovered machine (This will update the recovered 
system with the latest configuration and settings) 

4. Restore all data files onto the recovered system. 

 
^Back to top 
 

 

 

http://support.microsoft.com/default.aspx?scid=kb;en-us;320829
http://support.microsoft.com/kb/138365/EN-US/
http://support.microsoft.com/default.aspx?scid=kb;en-us;297684
http://support.microsoft.com/default.aspx?scid=kb;en-us;890553
http://support.microsoft.com/default.aspx?scid=kb;en-us;903237
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3 FreeBSD, SCO UNIX, AIX, MAC OS and Novell 

3.1 How do I install SecureITnet on FreeBSD? 

 

 
You can either run SecureITnet on a Linux version of Sun Java JDK (performance might not be optimized) or on 
a FreeBSD native Java SDK. 
 
Please do the following for the Linux version of Sun Java JDK option: 

1. Install Linux binary compatible port to the FreeBSD machine 

2. Install the Linux version of Sun Java 1.4.2 or above JDK onto the FreeBSD machine 

3. Create a symbolic link from $SecureITnet_HOME/jvm to $JAVA_HOME (installed in previous step) 

4. Run $SecureITnet_HOME/bin/RunBackupSet.sh [BACKUP_SET_NAME] to run your backup 

5. Run $SecureITnet_HOME/bin/Scheduler.sh to start the backup scheduler 

 
Please do the following for the FreeBSD native Java SDK option: 

1. Install Linux binary compatible port to the FreeBSD machine 

2. Install the Linux version of Sun Java 1.4.2 or above JDK onto the FreeBSD machine 

3. Compile the FreeBSD native Java 1.4.2 SDK using the JDK compiler installed in the previous step 

4. Install the FreeBSD native Java 1.4.2 SDK onto the FreeBSD machine 

5. Create a symbolic link from $SecureITnet_HOME/jvm to $JAVA_HOME (installed in previous step) 

6. Run $SecureITnet_HOME/bin/RunBackupSet.sh [BACKUP_SET_NAME] to run your backup 

7. Run $SecureITnet_HOME/bin/Scheduler.sh to start the backup scheduler  

 
^Back to top 

3.2 How do I install SecureITnet on SCO Unix? 

Please do the followings to install SecureITnet on SCO: 

1. Install Java 1.4.x or above onto your SCO Unix box 

2. Download obm-linux.tar.gz and expand it to $SecureITnet_HOME (e.g. /usr/local/obm) 

3. Delete $SecureITnet_HOME/jvm and create a symbolic link from $SecureITnet_HOME/jvm to the 
SCO Unix Java VM 

4. Run $SecureITnet_HOME/bin/BackupManager.sh to setup your backup set (or run 
$SecureITnet_HOME/bin/Configurator.sh if you are under command line mode. Then use the OBS 
Management Console to setup your backup sources and other settings) 

5. Run $SecureITnet_HOME/bin/RunBackupSet.sh [BACKUP_SET_NAME] to run your backup 

6. Run $SecureITnet_HOME/bin/Scheduler.sh to start the backup scheduler 

 

^Back to top 

3.3 How do I install SecureITnet on AIX? 

Please do the followings to install SecureITnet on AIX: 

1. Install Java 1.3.x or above (Java 1.4.2 or above recommended) onto your AIX box 

2. Download obm-linux.tar.gz and expand it to $SecureITnet_HOME (e.g. /usr/local/obm) 

3. Delete $SecureITnet_HOME/jvm and create a symbolic link from $SecureITnet_HOME/jvm to the 
AIX Java VM 
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4. Run $SecureITnet_HOME/bin/BackupManager.sh to setup your backup set (or run 
$SecureITnet_HOME/bin/Configurator.sh if you are under command line mode. Then use the web 
interface to setup your backup sources and other settings) 

5. Run $SecureITnet_HOME/bin/RunBackupSet.sh [BACKUP_SET_NAME] to run your backup 

6. Run $SecureITnet_HOME/bin/Scheduler.sh to start the backup scheduler 

 

^Back to top 

3.4 The Installer doesn’t seem to work. How can I manually install 

SecureITnet on Mac? 

Try manually installing SecureITnet on your Mac with the following instructions: 

1. Download http://download.ahsay.com/support/obm50-mac.zip  

2. Expand obm50-mac.zip into /Applications/SecureITnet 

3. Run "chmod -R 755 /Applications/SecureITnet" using Terminal 

4. Double-click the “Online Backup Manager” icon in /Applications/SecureITnet folder 

 
^Back to top 

3.5 Error occurred when Installing SecureITnet on Novell. 

Some users would have problems when trying to install SecureITnet on Novell Netware Client version. (The 
machine had met all the system requirements: Netware v5.1 and Netware Java v1.3.1). User could receive the 
following error message during installation. 
 

Exception in thread "main" 
Java.lang.noclass def found error.obm 
Java: class obm exited with status 1 

 
Check the following 

Please check if the SecureITnet_HOME environment variable set in SYS:\SecureITnet\bin\BackupManager.ncf is 
correct? 

 

envset SecureITnet_HOME=SYS:\SecureITnet 

envset SecureITnet_CLASSPATH=$SecureITnet_HOME\bin;$SecureITnet_HOME\bin\obm.jar; 
$SecureITnet_HOME\bin\obm-lib.jar 

envset LIB_PATH=$SecureITnet_HOME\bin 

java -mx384m -Djava.library.path=$LIB_PATH -cp $SecureITnet_CLASSPATH obm SYS:\SecureITnet 

 

Please change the SYS:\SecureITnet environment variable to your installation directory. 

 
^Back to top 

3.6 There is an error when backing up files on a remote NetWare 

server, what can I do? 

If you want to backup \\SERVER\SHARE that is located on a NetWare server and you are getting "Network 
drive is not accessible" error message. Please try adding the following command as a [Pre-backup command]  
 
net use \\SERVER\SHARE [PASSWORD] /USER:[DOMAIN | MACHINE_NAME]\[USERNAME] 
 
This will authenticate the current process with the NetWare server and therefore allow your backup to run 
correctly. 
 
^Back to top 

http://download.ahsay.com/support/obm50-mac.zip
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3.7 How do I change the .obm path for Novell?  

Please take a look at SYS:\SecureITnet\home.txt. It contains the path to the .obm directory. You can do the 
followings to make the changes: 

1. Stop the scheduler  

2. Change the entry in SYS:\SecureITnet\home.txt to another directory  

3. Copy the .obm directory from existing location to new location 

4. Startup the scheduler again 

5. Also, open “SYS:\SecureITnet\bin\BackupManager.ncf” and append the updated .obm path to the 
end of the whole command line. 

Example 

java -mx384m -Djava.library.path=$LIB_PATH -cp $SecureITnet_CLASSPATH obm 
SYS:\SecureITnet C:\[new location]\.obm 

 

^Back to top 

3.8 How to backup Oracle 7.3.4 on NetWare? 

To backup Oracle 7.3.4 on NetWare 5.1, it is not possible to use the Oracle agent, you need to do the followings: 

1. Backup all Oracle 7.3.4 datafiles, control files, and pfile. 

2. Use "exp" (export utility) to dump Oracle database to a dump file (make this a pre-backup 
command) 

3. Use SecureITnet to backup this file 

 
When you need to restore the database, just restore all datafiles, control files, pfile to its original location and 
use "imp" (import utility) to put the data back into Oracle database. 

 

^Back to top 

3.9 How do I backup file permissions in Linux? 

For version 5.1 or later, Linux file permission is also backed up during the backup operation. For other versions, 
please do the followings: 
 

1. Add a pre-backup command to dump the Access Control Lists of all files you want to backup into a 
dump file. For example, if you want to have all files under /home to a /ACL.txt, please add: 
 
   cd /; getfacl -R home > ACL.txt  
 
to your pre-backup command. 

2. Add "/ACL.txt" to the [Backup Source] of this backup set 

 
^Back to top 

3.10 How do I restore file permissions in Linux? 

For version 5.1 or later, the backed up Linux file permission will be restored automatically. For other versions, 
assuming the Access Control Lists is being stored in "/ACL.txt", please do the followings: 

1. Restore "/ACL.txt" from the backup server using SecureITnet 

2. Apply all Access Control Lists backup to all your backup files by running  
 
   cd /; setfacl --restore=ACL.txt 

 
^Back to top 


